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Your First Tab
Introduction to mTAB for Windows
What is mTAB for Windows
mTAB for Windows is a complete, turnkey solution for survey research analysis. mTAB's
spreadsheet-like ease of use promotes a natural dialog between the analyst and research data.
Designed as an "ad-hoc" data exploration tool, mTAB for Windows is targeted at market
analysts, product planners, and strategists that need quick and easy access to research data.
The mTAB service includes data processing which means that research data is immediately
accessible in a usable format, including the ability to trend and compare the study with other
similar studies.

How Can mTAB for Windows Help You
BIG QUESTIONS. FAST ANSWERS.
Executive summaries and tab books only scratch the surface - or raise more questions from your
management. Designing a tab specification for your research vendor takes too long. mTAB puts
you in control of your data. Your questions are answered as easily and as quickly as they are
asked.
ORDER FROM CHAOS.
mTAB promotes intensive data mining by allowing tabs to be constructed effortlessly and running
quickly. As the picture becomes clearer, mTAB allows you to answer “why” by quickly “drilling
down” into interesting subgroups of your tabulation.
LESS IS MORE.
mTAB can be used by anyone that needs quick and easy access to survey results. Most users
are planners, brand managers, analysts or strategists that need quick and easy access to survey
data without the cumbersome overhead of working on a mainframe system or with a statistical
application. mTAB’s spreadsheet interface is a natural working environment for analysts familiar
with MS-Windows based spreadsheets and presentation tools.
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Building Your First Tab
Step1: Select a Primary Study
Once you have started mTABWIN, mTABWIN will prompt you to choose a primary study.
1) We will select the “1996 Car Demo Study” database as our primary study.

Choose one of the following:
a) Double-click on the study description, or
b) Drag the study to the Primary Study box, or
c) Use the ↑ and ↓ arrow keys to move the highlight bar up and down the Available
Studies list. Then press ENTER to select the highlighted study.

Double click…

…or, drag to
here

• Figure 1 - Primary Study Selection

The studies list above are strictly for demonstration purposes. The list your system displays,
depends upon the studies you have installed for your system.
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Introduction to Topics and Questions
Once you have selected the 1996 Car Demo study as your Primary Study, mTAB will display a
list of available Topics and Questions. The buttons preceding the topic text facilitate the
expansion and contraction of the menu hierarchy. Questions are grouped together under these
Topics, which represent the top level of the hierarchy. Expanding a topic reveals theQuestions
associated with that topic.
As a general rule, it is very useful for you to obtain a copy of the survey you are working with
since mTAB databases are typically organized in the same order as the original survey.
Figure 2 below outlines the different parts of the Available Topics / Questions list.
Click on the

to expand a topic !

Collapsed Topic
Expanded Topic
Question Text

Click on the

to collapse a topic !

• Figure 2 - Topics and Questions
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Step 2: Select a Row Question
We will now select the row questions to be used in ourtab. For this demonstration, we will
construct a demographic profile (Gender, Age Bracket, Marital Status, and Education) for all
vehicles surveyed.
To select row questions (Demographic Profile):
1) Expand the Demographics topic.

Click on the

icon to the left of the Demographics topic text.

2) Select the Sex question:

a) Double-click on the question text, or
b) Drag the question text to the Row Selection View.
3) Repeat step #2 for the following demographic questions:

Age Bracket
Marital Status
Education

Double Click on
the text…
…Or Drag The Question To
Here !

• Figure 3 - Row Question Selection
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Step 3: Select a Column Question
We will now select the column question to be used in ourtab.
To select the column question (Vehicle Purchased):
1) Collapse the Demographics topic.

Click the

icon to the left of the Demographics topic text.

2) On the right hand side of the screen, click on the Columns tab

.

This will display the Columns Selection View.
3) Expand the Vehicle Characteristics topic.

Click on the

icon to the left of the Vehicle Characteristics topic text.

4) Select the Purchased Vehicle [Mailout Label] question.

a) Double-click on the question text, or
b) Drag the question to the Column Selection View.

• Figure 4 - Column Question Selection
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Step 4: Run the Tab
Now that we have selected rowand column questions we can run this tab.
Click on the

icon on the tool bar to begin running your tab.

Click here to run !

• Figure 5 - Running a Tab
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Step 5: Analyze The Results
After you’ve clicked the Run button, mTAB will display a progress bar of the tab run.
Upon completion of the tab run, mTAB will display the result in the Spreadsheet View:

55.56% of all Summit
buyers are Male !

• Figure 6 - First Tab Results (Spreadsheet View)

You can use the Arrow Keys and the PAGEUP / PAGEDOWN keys to move around the
spreadsheet to view your results.
The results you see here, are calculated as a percentage of the sample for each vehicle
surveyed. For example:
55.56% of all Eagle Summit buyers are Male
Note: If a weight is included in the study, weighted values will be used to calculate all
percentages.
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Step 6: Saving Your Tab
Once you have completed selecting your row and column questions, and run your tab, you can
save the tab.
To save your tab:
1) From the Question Selection View or the Spreadsheet View:

a) Click on the
icon located on the toolbar.
b) From the File menu, choose Save.
Note: If you have already saved your tab, and you have made no further changes
since that save, this icon will be “grayed” out.
2) Type the filename “1STTAB” in the File Name text box.

This filename must be eight characters or less.
3) Type in “This is our 1st tab” in the Tab Description text box.

This extended description may be up to 37 characters long. We suggest that you use this
description with all of your tab saves as it is extremely helpful for finding your tabs in the
future.
4) Click the OK button to save your tab.

mTAB will then tell you that it has saved your tab file.

• Figure 7 - Tab Save As Dialog

Note: This save procedure only saves the question and format information you used to build
your tab. It does not save the data results. If you need to regenerate these results at a later
date, it is very easy and fast to reload and rerun your saved tab. You may also export you data
to a .WK1 spreadsheet file. We will discuss exporting data later.
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Step 7: Loading Your Saved Tab
1) If you are currently in the Spreadsheet View, click the

icon from the tool bar to switch to

the Question Selection View.
2) Click on the

icon to display the Open dialog box.

3) Find 1STTAB.MTW under theFile Name list and click on it to display it in the box at the

top.
4) Click OK to open the tab.

Use Find Tabs to find a
saved tab !

• Figure 8 - Tab Open Dialog

You can also use the Find Tabs button on the right-hand side of the dialog box to help you
search for any saved tab. Clicking on this button will display a list with both the DOS tab filename
and the extended tab description.

• Figure 9 - Find Tab Dialog
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Basic mTAB Training
Demographic Profile Analysis
In this section of your mTAB training we will attempt to demonstrate the following mTAB topics:
Question Selection
Question Subset
Recoding
Saving Tabs and Exporting Data
Format Styles
Question Filters

Question Selection
This part of the exercise will take you through the selection of row stubs and column banners.
1) Clear out any questions currently selected.

From the Question Selection View, click on the

icon to start a new tab.

If you did not save the current tab questions, mTAB will prompt you to save the tab.
Note: If you are currently in the Spreadsheet View, click the
Selection View.

to display the Question

2) Bring the Topics and Questions List to the Foreground.

Once you have cleared the tab,click on the
the Topics and Questions list.
Also, click on the

tab on the left hand side to display

tab on the right hand side to display the Row Selection view.

3) From the Topics and Questions View, click on the

icon to the left of the Demographics

topic to expand that topic.
4) Select our demographic row questions.

Select the following questions:
Sex
Age Bracket
Marital Status
- Education
Total Family Income
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a) Double-click on the question text, or
b) Drag the question text to the Row Selection View, or
c) Click the right mouse button on the question text and choose Select.

Double Click on
the text…

…Or Drag The Question To Here !

• Figure 10 - Row Question Selection

Figure 10 shows what your screen should look like after selecting your row questions.
5) Bring the Column Selection View to the Foreground

Click on the

tab on the right hand side to display the Column Selection view.

6) From the Topics and Questions View, click on the

icon to the left of the Demographics

topic to collapse that topic.
7) Click on the

icon to the left of the Vehicle Characteristics topic to expand that topic.

8) Select the Purchased Vehicle [Mailout Label] question.

a) Double-click on the question text, or
b) Drag the question text to the Column Selection View, or
c) Use the right mouse button on the question text and choose Select.

12
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• Figure 11 - Column Question Selection

Figure 11 shows what your screen should look like after selecting your column question.

Question Subset
Since we are only interested in analyzing only the Dodge Neon models, and a few select Neon
competitors, we will need to subset thePurchased Vehicle [Mailout Label] question.
1) Highlight the Purchased Vehicle question in the Column Selection View.

Clicking on the question text once with either the left or right mouse buttons will highlight
the question.
2) To access the Subset Editor.

Choose one of the following:
a)
b)
c)
d)

Click on the
icon.
Click the right mouse button on the question and choose Subset.
Hit CTRL+S
From the Question menu, choose Subset.

3) Now we will select the responses for our subset.

Click the
box to the left of the Dodge Neon response(Dodge Neon).
The check box will then be marked with a :
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4) Repeat step 3, for the remaining Neon responses.

Tip: You can also highlight an entire block of vehicle responses by dragging the mouse
from the first desired response to the last desired response in the list, and then use the
right mouse menu to Select the highlighted block of responses.
5) Now we will select our competitive models (Ford Escort, and Honda Civic).

To Find a response label:
a) Press CTRL+F, or
b) Click the right mouse button, and choose Find.
The find dialog box will appear.
Type in “Civic” and press ENTER.
Note: The search is not case-sensitive.

• Figure 12 - Find Response Dialog

mTAB will then highlight the first occurrence of “Civic”.
mTAB can also find partial strings. If you typed “civ”, mTAB would find the first occurrence
of “civ”, which in this case is “Civic”.
Continue to select the Honda Civic response (refer to step 3 on selecting), and then repeat
step 5 to search for Ford Escort, and select all occurrences ofFord Escort.

Click this to subset a
response !

• Figure 13 - Response Selection
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6) Click OK to continue.

If you click CANCEL, the subset will not take effect.
7) Run the tab.

Click the

icon to run your tab.

8) Analyze and review your results.

Upon completion of the tab run, mTAB will display your tab results in the Spreadsheet
view.
Figure 14 shows the results of your tab run. Note that only the vehicles we chose in the
Subset Editor appear in this tab run.

• Figure 14 - Demographic Profile Results
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Creating Recodes
Recodes are a feature in mTAB that allows the analyst to re-aggregate the responses in a
question. For example if we wanted to look at respondents by those that areCollege Educated
and those that are Non-College Educated, we could use a recode to create a question that
contains these two aggregated responses.
This portion of the training will take you through the creation of a simple recode for the
Education question.
Accessing the recode editor
1) Return to the Question Selection View.

Click the

to display the Question Selection View.

2) Bring the Row Selection View To the Foreground.

Click on the

tab on the right hand side to display the Row Selection view.

3) Highlight the Education question.
4) Access the Recode Editor.

Choose one of the following:
a) Click on the
icon, or
b) From the Question menu, choose Recode, or
c) Click the right mouse button and choose Recode:
4 Steps to Creating a Recode
1) Give your recode a description.

This description will be displayed in your tab results and in the list of Topics and Questions,
so make it descriptive and meaningful.
For our example, lets call our recode: College / Non-College Graduate.
2) Create New Labels.

a) Click on the
icon, or
b) From the Edit menu, choose Add New Label, or
c) Click the right mouse button over the New Labels Section and choose Add New Label.
In the Description box, type: College Graduate and press ENTER.
See Figure 15 for an example.
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• Figure 15 - Add New Label Dialog

Then type: Non-College Graduate and press ENTER.
Click on Close or press ESC to close the Add New Label dialog.
3) Map Old Labels to New Labels

Now drag each of the Old Labels to the appropriate New Label. For example, you would
want to drag the old label - Post Grad Degree to the new label - College Graduate.
Refer to Figure 16 to see how we’ve mapped the Education responses for this recode.
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Step 4 Save Recode

Step 1 Create Recode Description

Step 2 Create new
labels

Step 3 Drag Old Label to its appropriate New Label

• Figure 16 - Recode Editor Components

4) Save the recode

Once you have mapped all of the Old Labels to New Labels, you need to save the recode.
By default, if you click on the OK button at the bottom of the screen, mTAB will create a
Session Recode. This recode will be available until you exit mTAB. Once you exit and
return to mTAB this recode will not be available. This is useful if a recode is relatively small
and non-complex, or is something you will only use once.
If a recode is large and complex, or is something you use on a regular basis, you want to
create a Saved Recode.
Click the

icon, or from the File menu, choose Save Recode As.

mTAB will then prompt you for a filename. You may type in an eight character filename, or
just use the suggested random name. Since mTAB maintains recodes for you, the
filename is not important unless you wish to share your recode with someone else.
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Viewing The Results of Your Recode
1) Return to the Question Selection View

Once you have saved the recode, click OK at the bottom of the Recode Editor screen.
mTAB will return you to the Question Selection View
After you’ve successfully created your recode from the preceding example, you will notice
a few differences when you return to the Question Selection View.
a) College / Non-College Graduates replaced Education in the Row Selection View.
b) A or a has appeared to the left of theEducation question in the Topics and
Questions View. These icons are used to expand and collapse the recode level.
2) Select the Education question again.

We will use the Education to compare to our new College / Non-College Graduate
recode.

a) New Recode replaced the
education question !

b) There is an additional level
below the education question !

• Figure 17 - Result of Creating a Recode
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3) Move the Education question

After you’ve selected the Education question for a second time, it will appear at the
bottom of the question list.
To move this question to just below theCollege / Non-College Graduates question, drag
it up the list and drop it in the position you want it to be.
4) Freeze Row and Column Question Text

Before we run this tab, we’ll set our spreadsheet so that the Question text for both the row
and column questions is always locked at the left and top side of the sheet.
To freeze spreadsheet titles:
a) Choose from the View menu, Freeze Question Text in Spreadsheet.
Now when we move around the Spreadsheet View, the Row and Column question
text will always be visible.
5) Run the tab

Click the

icon to run your tab.

6) Review the Results

Find the College / Non-College Graduate question. It should be about 3 pages down
from the top of the spreadsheet.
Notice in Figure 18 the percentage responses from theEducation question add up to the
two recoded responses.

• Figure 18 -Recode Tab Results
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Saving / Exporting
Saving the Tab
Once you have built up your tab, you more than likely will want to save your work. mTAB
provides the ability to save thestructure of your tab. mTAB does not save the data when you
save a tab. Instead, it saves everything needed to regenerate the data results. Then when you
reload the saved tab, you only need to re-run

the tab.

To Save your Tab
1) Choose one of the following:

a) Click the
icon, or
b) From the File menu choose Save or Save As
2) Type in a filename.

Since we have not previously saved this tab, mTAB will prompt you for a filename.
For our exercise:

Type “DEMOPROF” for the File Name
Type “Demo Profile (Neon and Competitors)” for the Description

Exporting the Data
If you wish to export your results for use in another software package, mTAB provides the ability
to create .WK1 files.
To Export Data
1) Return to the Spreadsheet View.

Click the

icon to switch to the Spreadsheet View.

2) Access the Export dialog

Click the

or from the File menu, choose Export.
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3) Type in a filename for the export file.

For our exercise: Type “DEMOEXP” for the filename
4) Export the Data

Click OK or press ENTER to export.

Question Formats and Format Styles
Up to this point in our training we have used a format style calledColumn %’s, Sample Base.
This format style displays each response as a percentage of the Column Sample total.Figure 19
gives a numeric demonstration of how aColumn %’s, Sample Base is calculated.
Camry V6

Camry V6

Weighted
Count

% Column
Sample

Education
Some HS or less
HS Grad
Some College
College Grad
Some Post Grad
Post Grad Degree
Weighted Sample Total

509
1,335
2,217
3,613
1,330
1,891

4.67%
12.25%
20.35%
33.16%
12.21%
17.36%

10895

509
= 4.67%
10895

100%

• Figure 19 - Numeric Example of % Column Sample

mTAB provides several types of pre-defined format styles for your use and we will demonstrate
how to apply these. We will also demonstrate how to create your own custom format styles.
Using Pre-Defined Format Styles
Let’s say for our current demographic example we would like to see the median Age and Income
instead of the % distribution. We would need to format these two questions with theMedian
format style.
1) Highlight Question(s) to be formatted

Go to the Row Question Selection View.
Highlight the Age Bracket question
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2) Click on the

on the toolbar to reveal the list of available styles.

3) Select a format from the list.

Select Median.
4) Repeat Steps 1-3 for the Family Income question.

See Figure 20 for the result of this format style selection.

Format Style Selection Box

Highlighted question to be
formatted

• Figure 20 - Changing a Question’s Style
5) Return to the Spreadsheet View

Since we did not make any critical changes to our tab request, we do not need to re-run
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icon to return to the Spreadsheet View. Then locate the
the tab. Instead, click on the
Age Bracket question on the spreadsheet.
6) Figure 21 shows the result of our style change for theAge Bracket question

• Figure 21 - Style Change Results

Creating Custom Styles
Now we want to format our Total Family Income question to display both theMedian and a
percentage distribution of each of the income breaks. We could do this one of two ways. First,
we could select the Total Family Income question twice and then apply the% Column, Sample
Base to one of the questions, and then applyMedian to the other income question. Or we could
create a custom style that contains bothMedian, and % Column, Sample Base. This section
describes how to create your own custom styles.
1) Return to the Question Selection View

Click on the

icon.

2) Highlight Question to be formatted

Highlight the Total Family Income question.
3) Access the Format Style Editor.

Choose one of the following:
a) Click on the
icon,
b) From the Question menu, choose Format Styles
c) Right click on the Total Family Income question and choose Format
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The Format Style editor will appear (seeFigure 22).
The list to the left is a list of all format styles available on your system.

List of available styles

Formats assigned to the
highlighted style

Click here to
create a new style
!

• Figure 22 - Format Style Dialog Components

A format is the calculated representation of your tab results. For example, Median, Total,
Weighted Counts, etc. Whereas, a style is a collection of formats. Styles allow you mix and
match different formats together so that you may easily format your tab results.
4) Create a New Style.

Click the New button to access the New Format Style editor.
Figure 23 shows the New Format Style editor.
5) Give the New Style a name.

In the Format Style Name box, type in:
Median / % Column Sample
This style description will appear in the list of available styles. Make sure you make this
name descriptive so that you may readily identify the contents of a style.
6) Choose an existing style upon which to base your new style.

This step is not necessary, but it does make it easier for you to start your new style. For
our example, select Median from the Based Upon Style box. This way we will have a
head start towards creating our new style.
7) Select the format options for your new style.

Find the format you wish to include under the “Available Format Options” section, and then
double-click on the format.
For our example, find % Column Sample under the Percentages option, and double-click
on the % Column Sample format.
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Depending on the type of format (Question or Response format), it will appear in one of
the following sections:
Format Display Order
• Question Formats (i.e. Median, Mean, Totals)
Formats for <<Questions Responses>> and Formatted Totals
• Response Formats (i.e. Percentages, Respondent Counts)
Format Parameters
• Optional Parameters
Double Click on formats you wish
to use for your new style

Name your Style here !

• Figure 23 - New Format Style Dialog
8) Change the order of the selected formats.

The Format Display Ordering section display the order in which formats will appear when
your style is used. If you wish to change the order of these formats, you may simply drag
them up and down the listed formats.
The <<Question Responses>> format is a placeholder for the formats contained in the
Formats for <<Question Responses>> and Formatted Totals section. The formats in
this section will be displayed in the same place as<<Questions Responses>>.
9) Save Your New Style.

Click the OK button to save your new style.
10) Highlight and Apply your new style

Now that we’ve created a new style, it will appear at the top of the list of “Available Styles”.

26

Productive Access, Inc. - mTAB For Windows Training

Basic mTAB Training

Highlight the new style we’ve created.
If you have already highlighted the question you wish to format (Step 2 above), click the
Apply button, otherwise click Close, and use the Style selection tool from the tool bar.

New Style we’ve created !

Click Apply to format selected
questions !

• Figure 24 - Format Style Dialog
11) View Your Results

Once you’ve applied your new custom style M
( edian / % Column Sample) to the Total
or switch to the spreadsheet view
.
Family Income question, either re-run your tab
Figure 25 demonstrates the final result of your new custom style. Notice how both the
Median and % Column Sample formats have been applied to theTotal Family Income
question.
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Both Median
and
% Column Sample
are applied !

• Figure 25 - Custom Style Format (Results)
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Filtering Your Tab
Now that we have covered the basics of tab design and analysis, we can discuss the
implementation and use of filter questions.
Filter Definition
A filter is a screening criteria defined by subsetting questions and combining these questions
together in an equation. For example:
Married Females with Family Incomes over $50,000
This filter above would combine the following questions and subsets:
Filter Question
Marital Status

Subset
Married
and

Sex

Female
and

Family Income

$50,001 to
$400,000 Or More

Once you have selected and subsetted filter questions, all subsequent tab runs willscreen each
respondent for the specified filter criteria. Those respondents which match your specified criteria
will be tabulated, and those respondents which don’t match will be ignored.
The table below demonstrates an example of 10 different respondents and their responses to the
three questions in our filter criteria. The responses which match our criteria for each filter
questions are highlighted in bold text, and those respondents which match all three of our filter
questions are indicated with aYes in the far left hand column.
Tabulated

Marital
Status

Sex

Family Income

Yes

Married
Married
Single
Married
Single
Single
Married
Married
Married
Married

Female
Male
Female
Female
Male
Female
Female
Female
Male
Female

$65,000
$75,000
$55,000
$70,000
$45,000
$80,000
$150,000
$40,000
$60,000
$55,000

Yes

Yes

Yes

So, for the above ten respondents, only four of the ten match our filter criteria. It is these four
respondents which will be included in our tab run. The other six respondents would not pass the
screening criteria and would be excluded from our analysis.
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Constructing A Filter
Now that we have defined filters, we will describe how to construct a filter in mTAB. This section
will describe how to construct a filter for our demographic profile example we’ve created.
1) Return to the Question Selection View

Click on the

icon.

2) Select the Filter Selection View

Click on the
the foreground.

tab (on the right side of the screen) to bring the Filter Selection View to

3) Select your Filter Questions

For this example, we will select the following questions for our filter criteria:
Sex
Marital Status
Family Income
You may select up to 10 filter questions.
Both the Filter Logic and Filter Description sections of the screen will be automatically filled
after you’ve selected your questions.
Note: The default filter logic is to AND together selected filter questions. The letters A, B,
and C to the left of the selected filter questions, are used for the Filter Logic. These letters
denote which Filter question is used in the logic.
Also, under the Filter Description section all filter questions will indicate<<SUBSET
REQUIRED>>. You will need to follow step 4 below to subset each of the filter questions,
otherwise filter questions which indicate <<SUBSET REQUIRED>> and will not be used in
the filter criteria.

Selected Filter Questions

Filter Logic
Note the and logic !
User defined filter description
Appears in footer or header

Automatic filter description
Note - <<SUBSET REQUIRED>>

• Figure 26 - Filter Components
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4) Subset each Filter Question.

Now that we have selected our filter questions we need to subset these questions for the
specific responses we intend to filter by. Use the table below for our filter criteria.
Filter Question
Marital Status
Sex
Family Income

Subset
Married
Female
$50,001 to
$400,000 Or More

If you need help with subsets, review the section Question Subset beginning on page 13.
Once you have subset each of your filter questions, the Filter Description section should
look like Figure 27 below. Note the range of responses for theTotal Family Income
question. For this question you must subset each response between $50,001 - $55,000
and $400,000 Or More. So you would also need to subset $55,001 - $60,000, $60,001 $65,000, and so on.

• Figure 27 - Filter Description
5) Give a Meaningful Filter Description.

Even though mTAB automatically creates an extensive Filter Description, this automatic
filter description does not appear on each page of your tab since it is normally too large to
fit conveniently at the top or bottom of your report.
Instead, we recommend you change the user definable description fromFilter Active
(default) to something more meaningful. For our example, let’s change this description to:
Married Females w/ Family Income $50,001 and Over
To change this description, place your cursor over the Filter Active description and click the
right mouse button. Choose Select All from the right mouse menu. This will select the
entire block of text. Now type the desired description. In this case typeMarried Females
w/ Family Income $50,001 and Over. This will overwrite the previous description.
This filter description will now appear at the top of every page of your report.
6) Run Your Filtered Tab

Now that we have constructed our filter criteria, run the tab . Figure 28 shows the
results of our tab. Notice how 100% of the respondents for this tab are Female and
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Married, with Family Incomes of $50,001 or more.
Note: We have removed the Age and Education in Figure 28 so that we could also show
Family Income. Your tab should still contain these questions and you will need to press
PAGE DOWN to review the Family Income Question.
100% Female,
100% Married, and
$50,001 Or More !

• Figure 28 - Filtered Tab Results (Married Females w/ Family Incomes $50,001 or More)
7) Save Your Tab

Click the
icon to save your tab. This should save your tab under the same file name
we have been working on (DEMOPROF.MTW). We will be using a part of this tab in a
later example, so be sure to save it.
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3
More mTAB

Purchase Reasons / Second Choice Vehicle Analysis
In this section of your mTAB training we will attempt to demonstrate the following mTAB topics:
Setting a Default Style
Multiple Question Selection
Finding Questions
Overlaying Tab Components
Sorting / Threshold
Top-n Report
rd

3 Level Question
Headers and footers
Spreadsheet Basics
Printing
Our tab for this example will analyzePurchase Reasons and Second Choice Vehicle for the
Neon and it’s competitors. We will also apply the same filter we built in our Demographic Profile
analysis - Married Females w/ Family Income of $50,001 or More.
1) Clear out all selected questions.

From the Question Selection View, click on the
icon to start a new tab. If you did not
save the current tab questions, mTAB will prompt you to save the tab.
Note: If you are currently in the Spreadsheet View, click the
Selection View.

to display the Question

2) Bring the Topics and Questions View and the Row Selection View to the

foreground.
Once you have cleared the tab,click on the
the Topics and Questions list. Also, click on the
the Row Selection view.

tab on the left hand side to display
tab on the right hand side to display

Setting a Default Format Style
The default format style, is the style that is applied to every question selected. You will
sometimes find it helpful to either temporarily or permanently change the default style setting.
For example, if you knew you would be working with scalar questions (i.e. Ratings questions) and
that you needed to format each of these questions with a top box response, it would be extremely
helpful to set your default style toTop Box or Top 2 Box.
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This section will take you through the creation of aTop Box style, and show you how to make
that style the default. This section assumes you have already created a custom style. If you
need a more detailed demonstration on creating custom styles, review the section entitled
Creating Custom Styles on page 24 for further help.
1) Highlight any Topic or Question from the list of Available Topics/Questions.
2) To access the Format Style dialog:

a) Click on the
icon, or
b) From the right mouse menu, choose Format, or
c) From the Question menu, choose Format Styles
This will display the Format Style dialog.
3) Create an New Style.

Click the New button on the right hand side of the Format Style window.
4) Give the Format Style a Name.

Type Top Box in the Format Style Name.
5) Choose an existing style to base your new style.

Base this style upon the Top 2 Box style.
Click the

from the Based Upon Style and selectTop 2 Box

6) Choose formats for your new style.

Expand the Top / Bottom Boxes Format option and double click on theTop 1 format.
The Top 1 format will appear to the right under the Format Display Ordering window.
Highlight the Top 2 format under the Format Display Ordering window and press the
DELETE key.
This should remove the Top 2 format from the Format Display Ordering window
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• Figure 29 - New Format Style for Top Box
7) Save your new format style.

Click OK to save the new custom styleTop Box.
This will return you to the Format Style dialog.
8) Set the Default Style.

Highlight the new style Top Box and then click Make Default. ( See Figure 30 )
If you wish to make this style the default every time you start mTAB, clickSave Default.
Top Box will now be denoted by a different color and will indicate “- Default” to the right.
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Step 1 Highlight Style to set as default
Note Default description

Step 2 Click Make Default

Optional Step 3 If you want this style
to be the default when
you start mTAB, click
Save Default

• Figure 30 - Setting New Default Style
10) Return to the Question Selection View.

Click Close to return to Question Selection View.
Now every question we select will be formatted with the styleTop Box.

Multiple Question Selection
The next three steps and the pictures on page37 demonstrate how to select multiple questions
that are in a continuous block.
Find the Purchase Reasons topic and press the

icon to expand the topic.

1) Highlight the first question you wish to choose.

Move the cursor over the first question you wish to select, and click the left mouse button
one time. Let go of the mouse button. This will highlight that question.
For our example, highlight the questionInterior Roominess.
2) Move the cursor over the last question in the list you wish to choose.

(DO NOT hold the left mouse button down as you move the cursor)
(DO NOT click the left mouse button)
For our example, move the cursor over the questionInterior Roominess.
Hold Down the SHIFT key and then click the left mouse button (hold the SHIFT key while
you are clicking with the mouse button).
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If you have done this correctly, the entire range of questions from Interior Roominess to
Gas Mileage will be highlighted. If this range is not highlighted, start over and repeat steps
4 -6.
3) Select the highlighted block of questions.

Place the mouse cursor over the highlighted range of questions and drag that block of
questions over to the Row Stubs selection view.
Note: This technique applies to all areas in which you can select questions.
If you are not comfortable with using the mouse to drag, you may also press the INSERT
key to select the entire highlighted block.

Step 1 - Highlight First Question to Select

Step 2 - Move the cursor over last question,
Hold down SHIFT key
Click Left Mouse Button

Step 3 - Drag the highlighted range over to the Row Stubs selection view,
or press the INSERT key to select.

Finding Questions in the Topics/Questions List
1) Highlight any Topic or Question from the list of Available Topics/Questions.
2) To Access the Find feature:

a) Press CTRL+F
b) From the Question menu, choose Find
c) Click the right mouse button and choose Find from the right mouse menu.
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The Find dialog will appear

• Figure 31 - Find Question Dialog
3) Provide a Search String

Type Seriously Consider for the Input Search String text box and then click OK.
mTAB will search the list of available Topics/Questions for your Input Search String. When
found it will highlight the first Topic or Question it finds containing the search text you
specified. This search is not case sensitive.
Your search should reveal Seriously Considered Other Makes. If not press CTRL+L to
find the next occurrence of Seriously Consider.
4) Select the Seriously Considered: Mk/Ser question.
5) Format the Seriously Considered: Mk/Ser question.

You must now reformat the Seriously Considered: Mk/Ser question to the Column %’s,
Sample Base style. The default style, Top Box, which we set earlier, does not make
sense for this question.

Overlaying Tab Components
Up to this point in the training, we have selected and formatted our Row Stub questions for the
Purchase Reasons / Second Choice Vehicle Analysis. We now need to complete the rest of our
tab for this analysis. Our tab still needs the following:
Column questions Filter criteria -

Neon and competitive models
Married Females w/ Family Income $50,001 and Over

We could select these questions and select their appropriate subsets, but if you recall from our
Demographic Profile exercise (starting on pageError! Bookmark not defined.) we had already
selected the Column and Filter Questions/Subsets. You may also recall that we saved the tab for
this exercise under the name “DEMOPROF.MTW”. We can use this saved tab to our advantage
and save ourselves time setting up the rest of this tab.
mTAB For Windows has a feature which allows you to selectively overlay any part of a saved tab
onto your current tab. In this case, we can overlay the Column Questions and Filter Criteria from
“DEMOPROF.MTW”. This section will take you through the steps needed to overlay these tab
components into our current tab.
1) Access the open dialog.

Click on the
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mTAB For Windows will ask you if you would like to save your current work to a tab file.
Click NO to continue (we will save this tab later).
The Open Tab dialog will appear.
2) Select the Load and Overlay Only Selected Components option

Located at the bottom of the dialog window.
The Tab Components To Overlay section will turn from gray to black.
3) Select tab components to overlay.

Select both the Columns and Filter option under the Tab Components To Overlay
section.

Select this option to
enable Tab Overlay
Select the Columns
and Filter options.
~
mTAB will overlay
these components
from any saved tab.
• Figure 32 - Tab Components Overlay
5) Select the saved tab from which you want to load the selected tab components.

For our example, select “DEMOPROF.MTW” and click OK to open.
If you have done this correctly, when you switch to the Column and or Filter views, they will
be filled with the Column question and Filter criteria saved in “DEMOPROF.MTW”.
See Figure 33 on page 40 for the correct result of this tab overlay.
6) Run the tab

Click the
icon to run the tab.
See Figure 34 on page 40 for the results of this tab run.
7) Save the tab.

From the File menu, choose Save As and provide a new tab file name. We suggest you
do this, instead of clicking the
icon since mTAB would save the tab with the same
name as the overlay file. Save this tab with the name “PURCHASE.MTW”.
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Figure 33 - Result of Tab Overlay

• Figure 34 - Result of Purchase Reasons / Second Choice Vehicle Analysis

Sorting
mTAB provides the ability to sort a tab by a single column of responses. There are two ways
mTAB can sort. The first method sorts selectedresponses within a question. For example, we
can sort the Seriously Considered: Mk/Ser question to determine the top models considered
for those respondents who purchased a Dodge Neon.
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The second sort method allows you to sort selectedquestions. For example, we can sort all the
Purchase Reason questions by their Top Box to determine the highest rated purchase reason
for respondents who purchased a Dodge Neon.
Question Sort
1) Switch to the Spreadsheet View.

Click the

icon to switch to the Spreadsheet View.

2) Highlight the column range of data you wish to sort.

You need only highlight a single column.
Include every row you wish to include the sort. There is no need to highlight the entire
block of data since mTAB will keep all related data together.
For our example, highlight the range of cells fromD4 to D41. This should include all
Purchase Reason questions from Overall Interior Roominess to Gas Mileage.
Note: If you wish to include all selected questions in the sort, you may highlight the entire
column, by clicking the D at the top of your spreadsheet.
See Figure 35 for an example of a highlighted sort range.
Click this to highlight
entire column !

• Figure 35 - Sort Range Selection
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3) From the Data menu, choose Sort.

• Figure 36 - Sort Type and Ordering Dialog
Left - Selected Range of Cells from D4 to D41
Right - Selected Entire Column D
5) Choose a Key Data Type and Sort Order.

The Key Data Type refers to the format you wish to sort your data by. This section of the
Range Sort dialog box will display a list of formats found in the range of data highlighted.
For our example choose Top 1 and Descending.
Note the difference in the Key Data Type lists inFigure 36 . The list on the left was the
result of selecting cells D4 to D41. The question data located in this range of cells has
been formatted with the Top 1 and Unweighted Sample Total Count formats.
The list on the right was the result of selecting the entireColumn D. This list also includes
% Column Sample, Subset: % Column Sample, and Sample: % Column Sample
formats. These additional formats come from theSeriously Considered: Mk/Ser
question which is highlighted as a result of selecting the entireColumn D.
mTAB will sort selected questions if you choose one of the following format types:
Statistics
Top / Bottom Box
Totals
6) Click OK to begin sort..

Figure 37 shows the results of our Question sort byTop 1 box.
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• Figure 37 - Results of Question Sort by Top 1 Box

Response Sort
1) Switch to the Spreadsheet View.

Click the

icon to switch to the Spreadsheet View.

2) Highlight the column range of data you wish to sort.

You need only highlight a single column.
Include every row you wish to include the sort. There is no need to highlight the entire
block of data since mTAB will keep all related data together.
For our example, highlight the range of cells fromE44 to E1655 or highlight the entire the
entire column E. This highlighted range should include allresponses to the Seriously
Considered: Mk/Ser question.
See Figure 38 for an example of a highlighted sort range.
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• Figure 38 - Sort Range Selection (Entire Column)
3) From the Data menu, choose Sort.

• Figure 39 - Sort Type and Ordering Dialog
Left - Selected Range of Cells from E44 to E1655
Right - Selected Entire Column E
5) Choose a Key Data Type and Sort Order.

The Key Data Type refers to the format you wish to sort your data by. This section of the
Range Sort dialog box will display a list of formats found in the range of data highlighted.
For our example choose Top 1 and Descending.
mTAB will sort selected responses to a question if you choose one of the following format
types:
Percentage Calculations
Respondent Counts
6) Click OK to begin sort.

Figure 40 shows the results of our Response sort by% Column Sample.
Note how only the responses to the Seriously Considered: Mk/Ser have been sorted.
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• Figure 40 - Results of Response Sort by % Column Sample

Top N Report
In addition to the basic sorting features describe above, mTAB for Windows provides an
extremely unique and useful feature called Top N Report. Just like the basic sort feature, Top N
Report provides a sorted report of your tab. But unlike the basic sort, Top N Report provides a
report with multiple columns sorted as opposed to a single column.
1) Switch to the Spreadsheet View.

Click the

icon to switch to the Spreadsheet View.

2) Highlight the range of data you wish to include in your Top N Report.

Click the box to the left of theA Column and above Row 1 to highlight every cell in the
spreadsheet. The will ensure that we include all questions or responses in our report.
Note: You may also highlight a smaller portion of the spreadsheet. The Top N Report will
then only include those questions or responses contained within the highlighted range of
cells.
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Click this to highlight all cells !

• Figure 41 - Top N Report Data Highlight
3) Choose one of the following:

a) From the Data menu, choose Top N Report, or
b) Press CTRL+R, or
c) Click the

icon

mTAB will display the Top N Report Options dialog

• Figure 42 - Top N Report Options (Data Type Selection)
4) Choose and Row Data Type and Column Data Type.

Highlight the Top 1 Row Data Type and the Question Responses Column Data Type.
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This tell mTAB to create a Top N Report sorted byTop 1 box. Only those questions which
have the Top 1 box format will be included in the report.
5) Change the Number of Top N Responses.

Click on the Display Options tab.
Change the number of Top N Responses to be displayed from 10 to 5.
mTAB will now generate a Top N Report which displays the top5 responses.
Change this value to
the number of Top N
Responses you would
like your report to
display.
~
Change to 0 to display
all responses !

• Figure 43 - Top N Report Options (Display Options)
6) Change the Report Threshold.

Click on the Threshold Options tab.
This dialog provides the ability to set a threshold value. When a threshold value is set,
mTAB will ignore values that fall below this value.
Set the threshold value to 25.00. With this set, mTAB will ignore those questions which
have a Top 1 box less than 25%.

• Figure 44 - Top N Report (Threshold Options)
7) Click OK to generate a Top N Report.

mTAB will now begin to generate the Top N Report. Upon completion it will display the
Top N Report View.
8) Review and analyze the report.

Figure 45 displays the result of our Top N Report. Note how some of our columns have
fewer than five top responses. This was the result of the threshold we set. Only those
questions with a Top 1 Box above 25% have been displayed.
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Each column is sorted
independently !

Some columns have fewer than 5 responses as a
result of the 25% threshold !

• Figure 45 - Top N Report View
Top 5 Purchase Reasons by Top 1 box for Neon and Competitors
Display only those with Top 1 box of 25% or Better
9) Print or Export this report.

Click
Click

to print.
to export.

10) Return to the Spreadsheet View.

Click

to exit the Top N Report View.

11) Let’s repeat the steps above for theSeriously Considered: Mk/Ser question. Every step

(1-10) is identical except for steps 4 (Row Data Type selection) and 6 (Threshold).
To sort the Seriously Considered: Mk/Ser question, choose % Column Sample for your
Row Data Type (Step 4) and turn chooseZero Threshold Value under the Threshold
options tab (Step 6). See Figure 46 for results.
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• Figure 46 - Top N Report
Top 5 Seriously Considered: Make/Ser

Zero Suppression
The Zero Suppression feature in mTAB for Windows allows you to suppress those rows or
columns which total zero. For example, theSeriously Considered: Mk/Ser question we
currently have selected, has quite a few rows, and a column, which total zero. We can remove
these rows and column from our report using the Zero Suppression feature. This feature helps to
cut the clutter of responses from your report.
1) Switch to the Spreadsheet View.

Click the

icon to switch to the Spreadsheet View.

2) From the Data menu, choose Zero Suppression.
3) Choose Both under the Zero Suppression option.

mTAB will indicate that it is updating your spreadsheet and display a progress bar. When
mTAB completes this process you will notice that the Seriously Considered: Mk/Ser
question now has fewer responses. mTAB has removed all those responses which
totaled zero. See Figure 34 and Figure 47 to review the differences after using Zero
Suppression.
Note: mTAB accomplishes Zero Suppression by subsetting questions which have been
suppressed. mTAB subsets those responses which have data, and ignores those
responses that don’t have data. This is important to keep in mind after zero suppression,
especially when applying filters.
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• Figure 47 - Zero Suppression Results

Threshold
In addition to the Zero Suppression feature described in the previous section, mTAB provides the
ability to remove responses which fall below a user defined Threshold. For example, if we could
use Threshold to view only those responses which are 7% or more of the total sample.Figure 48
shows an example of what type of response (highlighted in bold) would be removed when a
threshold of 7% is applied.
Toyota
Camry V6
Cpe
Model of 2nd Choice
Toyota Car Unsp
Toyota Avalon
Toyota Camry
Toyota Celica
Lexus SC300
Toyota 4Runner 4X2
Toyota 4Runner 4X4
Nissan Maxima/810
Nissan Altima
Nissan Pathfinder
Acura Integra
Acura Legend
Acura Vigor / TL
Honda Unsp
Honda Car Unsp.
Honda Accord

0.00%
0.00%
5.08%
5.08%
5.08%
0.00%
7.22%
0.00%
0.00%
0.00%
7.22%
5.08%
5.08%
0.00%
5.08%
12.30%

Removed from the
tab report with a
threshold of 7%.

• Figure 48 - Threshold (Bolded responses removed by a threshold of 7% or more)

To apply a threshold to a tab:
1) Switch to the Spreadsheet View.

Click the
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2) Highlight the column to which you wish to apply a threshold.

You may also highlight the range of cells within a single column. Only the highlighted cells
will have the threshold you specify applied. All other cells will not be affected.
Highlight Column E (Dodge Neon). To highlight the entire column, click the letter of the
column at the top of the spreadsheet.
3) From the Data menu, choose Threshold.

• Figure 49 - Row Threshold Data Type and Threshold Value Selection

3) Choose a Key Data Type.

The Key Data Type box will list the formats that mTAB has found in the range of data you
have highlighted. The format you choose here will determine which values are affected by
the specified threshold. Your results will vary depending upon the Data Type you choose.
For our example choose % Column Sample.
4) Specify a threshold value.

For our example type in 12. This value is relative to the Key Data Type. In this case, the
value 12 would represent 12% since we have % Column Sample chosen. If the Key
Data Type were Unweighted Respondent Counts. The value 12 would represent 12
respondents.
5) Click OK to apply Threshold.

mTAB will indicate that it is updating your spreadsheet and display a progress bar. When
mTAB completes this process you will notice that the Seriously Considered: Mk/Ser
question now has fewer responses. mTAB has removed all those responses which were
less than 12% of the entire sample.
6) Re-run the tab.
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• Figure 50 - Results of a 7% Threshold Applied to Dodge Neon

3rd Level Question
Let’s say we now want to analyzePurchase Reasons for the Neon and it’s competitors by Male
and Female respondents. One method of accomplishing this would be to create a filter by
gender and run the tab filtered for Male respondents and then re-run the tab filtered by Female
respondents.
rd

rd

We could also use a 3 Level Question to accomplish the same task above. The 3 Level
Question provides the ability to tier the responses of that question beneath each Column Banner
response.
See Figure 51 for an example of a third level question tiered between a column response.
New Vehicle Model
Toyota Camry V6 Sdn
Female
A - Engine Performance
Top 1
81.26
Unweighted Sample Total Count
28
A - Int Roominess
Top 1
Unweighted Sample Total Count

75.71
28

Male

Total

77.23
46

78.74
74

54.73
44

62.69
72

• Figure 51 - Example of 3rd Level Question Structure
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Columns Tiered Beneath Banner
1) Switch to the Question Selection View.

Click on the

icon.

2) Remove the Sex filter question.

Since our current tab has theSex question selected as a filter forFemale respondents, we
rd
will need to remove this question in order to use theSex question in our 3 Level.
Click on the
the foreground.

tab (on the right side of the screen) to bring the Filter Selection View to

Highlight the Sex question and press the DELETE key.
This will remove the Sex question from the Filter View.
3) Bring the 3 Level Selection View to the foreground.
rd

Click on the

tab (on the right side of the screen).

4) Choose the Create Columns Tiered Beneath Banner option.

Located in the Page Display section.
This is the default selected option.
5) Choose the Responses of the Selected Question option.

Located in the Page Built From section.
This is the default selected option.
6) Select Your Third Level Question

Expand the Demographics Topic and double click on theSex question.
rd
The Sex question will appear under the 3 Level Question section.
7) Run the Tab

Click the

icon.

• Figure 52 - 3rd Level Question Results
Columns Tiered Beneath Banners
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Z-Axis Orientation
rd

We can also change the orientation of our 3 Level Question to display each response from the
rd
3 Level on separate pages (Z-Axis).
1) Return to the Question Selection View.

Click on the

icon.

2) Bring the 3 Level Selection View to the foreground.
rd

Click on the

tab (on the right side of the screen).

3) Choose the Create Pages (Z-Axis) Above Banners.

Located in the Page Display section.
This is the default selected option.
4) Return to the Spreadsheet View.

Click the
icon.
There is no need to re-run this tab since we have not made critical changes to the tab
request.

• Figure 53 - Third Level Question
Z-Axis Orientation
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4
Advanced mTAB
Additional Analysis
Rejection Reasons
1) Select Your Row Question(s)

Select the Reasons Not To Buy question located under the Makes Considered topic.
2) Format Your Row Question(s)

Format the Reasons Not To Buy question with the Makes Considered style.
3) Select Your Column Question(s)

Select the question Seriously Considered: Model under the topic Makes Considered.
4) Format Your Column Question(s)

Format the Seriously Considered: Model question with the Subset and Sample Total
style.
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• Figure 54 - Row and Column Questions for Rejection Analysis
5) Subset your column question to the following:

Dodge Neon
Ford Escort
Honda Civic
6) Run the tab.

Click the
icon to run your tab.
See Figure 55 for the results of this tab.
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• Figure 55 - Results of Reject Reasons

Second Choice
1) Select Your Row Question(s)

Select the Model of Second Choice question located under the Second Choice Vehicle
topic.
2) Format Your Row Question(s)

Format the Model of Second Choice question with the Column %’s, Sample Base style.
3) Select Your Column Question(s)

Select the question New Vehicle Model under the Vehicle Purchased topic.
4) Format Your Column Question(s)

Format the New Vehicle Model question with the Subset and Sample Total style.
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• Figure 56 - Row and Column Questions for Second Choice Vehicle Analysis

5) Subset your column question to the following:

All Neons
All Escorts
All Civics
6) Run the tab.

Click the
icon to run your tab.
See Figure 57 for the results of this tab.
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• Figure 57 - Results of Second Choice Vehicle Analysis

Productive Access, Inc. - mTAB For Windows Training

59

